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Plot Templates – Conceptual Design
CADSWES:  Neil Wilson, David Neumann, Edie Zagona
1. Introduction
The idea of a plot template is to allow a user to create a plot involving particular slots on particular objects and then generalize this plot as a “template” so it can be easily applied to other objects and slots of the same type. 
For example, a user might create a 3X1 plot that has the following curves by plot:
· BigReservoir.Pool Elevation and BigDataObject.FloodGuide
· BigReservoir.Storage and DeepReservoir.Storage
· BigReservoir.Outflow
Turning this plot into a template should give the user the ability to easily substitute reservoirs, for example, into the template:
· SmallReservoir for BigReservoir
· ShallowReservoir for DeepReservoir
· SmallDataObject for BigDataObject
This could then create the 3X1 plot that has the following curves by plot:
· SmallReservoir.Pool Elevation and SmallDataObject.FloodGuide
· SmallReservoir.Storage and ShallowReservoir.Storage
· SmallReservoir.Outflow
Note that the user would not be able to substitute an object of a different type, such as a reach, into this template for the reservoir because the slots specified with the reservoirs are not necessarily applicable to other object types.
Alternately, the user might use the template to substitute slots:
· PoolElevation for Storage
· Inflow for Outflow
This could then create the 3X1 plot that has the following curves by plot:
· BigReservoir.Pool Elevation and BigDataObject.FloodGuide
· BigReservoir.PoolElevation and DeepReservoir.PoolElevation
· BigReservoir.Inflow
In these examples, the template would not be changed, but mapping template items to different objects and slots allows different plots to be created from the template.
2. Requirements
The following requirements have been identified for plot templates:
· A template will be created from an existing plot.
· Templates need to be saved to be accessible for future use.
· Templates should be transferrable between models (export and import).
· Templates, like actual plots, may contain up to nine different plots on the plot page.
· Source data for curves in the plots of a template need to be represented in a manner that readily allows substitution of data from real objects in a model. 
· After substitution of data, templates will allow creation of a plot with the newly specified data.
· Templates remain unchanged by substitution of data to create plots.
· Source data specification for a curve in a plot varies according the curve type. Templates will need to present source data for the different curve types as follows:
· SeriesCurve – slot, column
· TableCurve – slot, X column, Y column
· TableContourCurve – slot, X column, Y column, Z column
· PeriodicCurve – slot, column
· ParametricCurve – X slot, Y slot
· A slot in source data specifications for curves may be made up of the following substitutable components:
· Object,  slot
· Object,  account, slot
· Supply
· In addition to curve source data, the template should allow modification of titles associated with the plot.


3. General Approach
Plot templates are closely linked to plots, so they will appear under the Output Manager in RiverWare as a new device type. A template will need to contain all of the information associated with a plot page (1 to 9 plots, with the curve, title, marker, axes, grid, and background color information associated with each), so each template will contain an instance of a plot page as currently defined in RiverWare.
The template will also need to contain additional information for each curve represented in the plots on its plot page. When a plot is turned into a template, information about the “components” of any slot referenced in the curve source data will need to be recorded. A physical slot will need to have the object name and type and the slot name and type recorded. An accounting slot will need to have the object name and type, account name and type, and slot name and type recorded. A supply will need to have the supply name recorded. This information is available from the slot pointer in the curve source data. However, if the template is exported and imported into a different model with different objects, the curve slot pointers will be invalid and no information about the potential substitutable components of the source slots would remain without the additional information recorded in the template. 
When a new plot is created from the template, the substituted data specified by the user for a curve in the template will be resolved to a slot pointer in the model for that curve in the new plot. If data does not resolve to a slot pointer, the user can be given an error or warning (note that plots do currently support curves without slot source data and will maintain these unplotted curves as “placeholders” that can be assigned slots later in the plot’s Curve Configuration dialog).


4. Plot Template Dialogs
4.1  Save As Template Dialog
Menu items called Create Template will be added to the File menu in the Plot dialog and the Plot Configuration Dialog to allow creation of a template from a plot. This link will bring up a template “save as” dialog to specify information for creating the template.
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The upper part of the dialog will contain a text box for specifying a multi-line description of the template. This might describe the purpose of the template and its plots.
The center of the dialog will contain a Titles frame where the user can specify via check boxes whether Plot Titles, Axes Titles, or Curve Titles will be editable as text for plots generated from the template.  If Axes Titles and Curve Titles are not checked, they will get the normal default names in the plots generated from the template (unit name for an axis and source slot name for a curve).
The lower section of the dialog will contain a Curve Source Data frame where the user will be presented with a list of potential source data tokens for the plot (objects, accounts, slots, supplies which could be substituted to change the source data for a generated plot). With adjacent check boxes, the user will indicate which of these tokens they would like to have substitutable in generating plots from the template.
The bottom of the dialog will have a “Save As Template” and a “Cancel” button. Save As Template will bring up a dialog with a list of existing templates and a text edit line for the user to enter a name for the template, which will then be saved and added to the Output Manager.


4.2  Plot Template Dialog
The Output Manager currently allows export and import of output devices and this will also apply to plot templates that will reside in the output manager. Generating or Editing a plot template from the Output Manager will open the Plot Template dialog.
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The upper part of the Plot Template dialog will have a non-editable text box that will contain the template’s description. An adjacent plot layout symbol will show the layout of plots contained in the template. These will give the user basic information about the template and its purpose. 

A Titles frame will follow that will contain a tabbed widget. Potential tabs are Plot, Axis, and Curve depending on what types of titles were specified to be editable when the template was created. Each tab will present a list of the titles in that category, where the user can edit the strings to create new titles for plots generated from the template.
The lower part of the dialog will contain a Curve Source Data frame where the editable curve tokens available in the template will be presented in a list view. The columns will be Edit, New Name, Token Type, and Original Name. The edit column will contain an edit button that will bring up a selector appropriate to the token where the user can select replacement token data (for instance if the token is a reservoir object, the selector will be a GUS selector initialized to allow selection of a reservoir from the model). The selected replacement data will populate the New Name column for the list item. Note that for some slot tokens (such as Table and Periodic), there will also be a column selector (spinner) that will appear in the list view in a column adjacent to the New Name to allow the user to specify the desired slot column for the source data. 
The bottom of the dialog will have three buttons:
· Create Plot from Template
· Clear Data from Template
· Cancel
Clear Data from Template will discard any changes or selections the user has made and will restore the original template information in the dialog. Create Plot from Template will copy the plot page that exists underneath the template, assign the specified titles into the plot page copy, resolve the token information into slot pointers for the curves in the plot page copy, present the user with a “save as” dialog to specify the name for the new plot, add the plot to the Output Manager, and bring up the new plot’s dialog. Cancel will exit the dialog with no plot being created.
It may be nice to have an optional plot template selection list on the right side of the dialog, similar to the list showing plots that exists for the plot dialog. This would allow the user to click and use different templates as they are creating plots from the plot template dialog.


5.  Template Implementation
Implementing the plot template task would require the following changes:
Modify cwOutputDevice class for the new template device
PlotTemplate class
Create as member of cwOutputDevice hierarchy with the following data and methods:

Data
PlotPageInfo (check into registering of these in Output Manager)
List of curve info for all plots in plot page (list of CurveTemplateInfo structs)
List of substitutable tokens 
Methods
virtual generateOutput
constructor PlotTemplate(PlotPageInfo)
getType()
getTypeString
dump
createTclCmd
PlotTemplateInfoCmd
getCurveTemplateInfo

Save As Template Dialog
Create .ui file
· Description
· Title Options
· Curve Source Data Options
· Save As Template, Cancel buttons
Dialog Coding
· Create PlotPageTemplate object from source PlotPageInfo object
· Constructor will interpret source plot’s curves into a list of Curve Template structs.
· Constructor will distill Curve Template structs into a list of potential substitutable tokens.
· Save Template code will mark user-indicated titles and tokens as substitutable in the PlotPageTemplate instance, will bring up a dialog with a list of existing templates and a text edit line for the user to enter a unique name for the template,  save template with the user-specified name, and add it to Output Manager.
Plot Template Dialog
Create .ui file
· Description
· Indicator of plot page layout
· Titles edit frame – tabbed dialog of listed editable titles for Plot, Axes, Curves. Tabs enabled depending on template creation specs.
· Curve Source Data Tokens frame – list of editable tokens with the columns Edit button, New Name, Type, Original Name.
· Create Plot From Template, Clear Plot Data from Template, Cancel buttons
· Optional template selection list frame on right side of dialog
Dialog Coding
· Populate widgets from Template class instance
· Tokens will require selectors to be instantiated for editing that is restricted to either the object type, the accounts for an instance of one of the objects using the account, the slot type for an instance of one of the objects using the slot, or the supplies in the model.
· Clear Data from Template button will re-initialize template dialog from Template class, clearing any previous user data selections and title changes.
· Create Plot From Template button will present the user with a “save as” dialog to get a plot name from the user, make a copy of the plot page owned by the template, assign titles specified by the user in the dialog to the plot copy, take the user-specified token information along with the list of curve template information to identify slot pointers for the curves and assign these to the curves in the plot copy, save the plot copy with the user-supplied name, add it to the output manager, and bring up the new plot’s dialog. 


6.  Other Plotting Work
In addition to creating plot templates, a number of other plotting tasks have been identified as follows:
· Create a capability to add notes to the plot canvas.
· Allow for easy specification of a time range for the start and end of the plot display.
· Add the capability to save or replace a single plot in a multiple plot page.
· Limit the types of curves that can be added to a plot based on the plot “type”.
Each is discussed in the following sections.
6.1  Plot Notes
This capability would allow the user to add text in the form of a note anywhere on the plot canvas (the part of the plot where curves are displayed). This would allow users to add comments or labels to help clarify the information presented on the plot.
Notes would be implemented via the “Marker” capability present in the Qwt plotting package. The note would essentially be a marker, but with no lines or symbols, only the label. 
The work flow for adding a note could be right clicking on the canvas where the note is desired, having an item available in the context menu to add a note, where clicking this would bring up a Note Editor dialog where the user enters the text, specifies a color, and picks a font for the note. The location information in the dialog would already be filled in based on the position of the original right click. Clicking OK or Apply would create the note (or Cancel would close the dialog without creating the note). 
A Note Manager dialog, similar to the existing Marker Manager dialog, would be available from the Plot Dialog’s Edit menu. This dialog would list existing notes and allow notes to be edited, deleted, or added.  Editing or adding a note would bring up the same Note Editor dialog as discussed above.
Implementation of the task would include the following work:
Create new Note Editor dialog
· Text box for entering the text.
· A Set Note Color button that brings up a Select Color dialog for selecting the color for the note.
· A Set Note Font button that brings up a Select Font dialog for selecting the font for the note.
· X-Position and Y-Position line edit widgets that present note position in terms of the selected X and Y axes units.
· Ok, Apply, and Cancel buttons .
Create new Note Manager dialog
· A list view widget with single selection enabled to show existing notes.
· Add Note, Delete Note, and Edit Note buttons below the list.
· Delete Note deletes the selected note.
· Add Note or Edit Note brings up the Note Editor dialog for the new or existing note.
· Close button on bottom of dialog exits the manager.
Modify PlotInfo structure
· Add members to contain the notes information for a plot.
· Write save and load code for transferring notes information to the model file.
Modify SlotPlot class
· Add a list of QwtPlotMarkers to hold the notes.
· Add methods for inserting note, removing note, and modifying note attributes.
· Add code for notes to savePlotInfo and loadPlotInfo methods that save to or create plots from a PlotInfo structure.
Modify PlotDialog
· Add item to the Edit menu to access the Note Manager.
· Add item to context menu to create a note.
· Add the create note handler code to open a Note Editor dialog using the canvas location information to initialize the location widgets.
6.2  Plot Time Range
The object of this task is to give users an easy way to specify the start and end times for a plot display in the Plot Dialog if the plot is a time series. This can currently be accomplished by opening the Axis Configuration dialog from the Edit menu, selecting the Lower X axis, and setting the date/time spinners for the Minimum and Maximum Bounds of the axis. Being able to do this directly in the plot dialog would save having to go through the steps of opening the separate dialog.
The controls that would be required include a date spinner for the start time and one for the end time. The real estate in the toolbar for the Plot Dialog is already mostly filled, so adding these controls will require some planning, perhaps implementing a second toolbar line. The details of the toolbar design will be determined as part of the task.
Implementation of the task would include the following work:
· Design of the controls and toolbar.
· Adding the controls to the Plot Dialog.
· Code to enable and disable the controls depending on if the X axis of the plot is time.
· Handler code for the controls to adjust the bounds on the time axis.

6.3  Save or Replace a Single Plot in a Plot Page
This task would create greater flexibility in using plot pages with multiple plots. If single plots have been created separately, this capability would allow them to be easily assembled into a multiple plot page by importing the single plots into the various multiple plot positions. Or one plot in a multiple plot page could be replaced by any plot page containing a single plot in the model. Alternatively, if a plot was created as part of a multiple plot page, a copy could easily be saved separately as a single plot page. 
Implementation of this task would include the following changes:
	PlotPageInfo simulation class
· Add new method named saveAsNewPlot(newname, row, col) to create a new plot page with the given name and initialize it with the plot information in position (row, col) of the current plot page.
· Add a new method named replacePlot(PlotPageInfo*, row, col) to take the plot information from the given 1 by 1 plot page and copy it into the current plot page at position (row, col).
Create new SinglePlotList dialog
· Present a list of all the 1 by 1 plot pages in the model.
· For “Save” allow them to enter a unique name for the new 1 by 1 plot that will be created.
· For “Replace” allow them to choose one of the items from the list to identify the plot to be copied into their plot page.
· Return new name or existing plot page to the calling code.
PlotDialog
· Add a “Plot” menu with items “Save Selected Plot As…” and “Replace Selected Plot With”.
· In context menu for a plot, add items “Save Plot As…” and “Replace Plot With…”.
· Write button handler code for these to call the new SinglePlotList dialog and get a new plot name or existing plot page.
· In Save case, call the saveAsNewPlot(newname, row, col) on the dialog’s PlotPageInfo class member to create the new plot
· In Replace case, call the replacePlot(PlotPageInfo*, row, col) on the dialog’s PlotPageInfo class member to copy in the identified plot.
PlotPage Configuration Dialog
· Add two buttons below Select Graph panel to “Save selected Graph As…” and “Replace Selected Graph With…”.
· Write button handler code for these to call the new SinglePlotList dialog and get a new plot name or existing plot page.
· In Save case, call the saveAsNewPlot(newname, row, col) on the dialog’s PlotPageInfo class member to create the new plot.
· In Replace case, call the replacePlot(PlotPageInfo*, row, col) on the dialog’s PlotPageInfo class member to copy in the identified plot.
6.4  Limit Curve Choices Based on Plot “Type”
Limiting the types of curves that can be added to a plot based on its plot “type” could help guide the user in creating reasonable plots. Three plot “types” along with the curves they can accept have been identified:
· Series
· X axis has units of time
· Can accept Series and Periodic curves
· Table
· X axis is not time
· Can accept Table and TableContour curves
· Parametric
· Two series slot plotted against each other as a scatter diagram
· Each point represents a timestep
· The two axes are the units of the two series
· Can accept a Parametric curve
 The plot “type” is uniquely determined by the first curve put on the plot, or could be selectable by the user for a plot with no curves. 
There are a number of questions associated with the implementation of this task that would need to be finalized as part of the work. Implementation items and the associated questions follow:
PloPageInfo simulation class
· Add enumerated data type for the plot type.
· Add method called getPlotType(row, col) to get the plot type for a plot in position (row, col) of the plot page. This could check the curve type of the first curve in the plot to determine the type.
PlotDialog
· Add code to disable the appropriate “add curve” menu items under the Data menu based on the plot type of the selected plot on the plot page.
· Add code to disable the appropriate “add curve” items in the context menu for an individual plot on the plot page based on the plot type.
· Display the plot type of the page’s selected plot in the toolbar of the dialog? Is there room? Should we use a symbol?
· Should there be a combo box in the toolbar for the user to specify the plot type if there are no curves on the graph? Is there room? Can we wait till they put a curve on the plot which will determine its type?
· Should plot type be shown for plot pages with a single plot along with the name in PlotPageSelectPanel? Usefulness vs. space considerations. Show anything for plot pages with multiple plots (mixed or type if all same)?
SlotPlot dialog
· Modify the setAxes method so that a second x axis is never used? If any user has created a plot with two x axes, this would invalidate their plot. (Perhaps ElevVolumeTable vs. ElevAreaTable with elevation on the y  axis would be an example of this?)
PlotMembershipDlg
· Add code to disable the appropriate “add curve” buttons on the dialog based on the plot type of the selected plot in the plot page of the calling plot dialog.
OutputConfig dialog
· Limit slot selector by selected plot’s type? Look at how this fits with the other device types that use this same dialog and same selector.
· Add display of selected plot’s type?
· Allow user to choose selected plot’s type if no slots have been added yet?
OutputManager dialog
· Add a column to display a plot type for plot pages with a single plot? Show anything for plot pages with multiple plots (mixed or type if all same)? Column won’t be applicable to all the other device types displayed.


7.  Time Estimates

Plot Templates
Hours	Task
2	Modify cwOutputDevice class
8	Modify Plot Dialog, PlotConfiguration Dialog, Output Manager Dialog
16	Create Plot Template Class
10	Create Save As Template Dialog
24	Create Plot Template Dialog
4	Testing
6	Documentation
	
70	Subtotal


Plot Notes
Hours	Task
12	Create Notes Manager Dialog
24	Create Notes Editor Dialog
8	Modify SlotPlot Class
4	Modify PlotInfo Struct
6	Modify Plot Dialog
6	Documentation
	
60	Subtotal


Plot Time Range
Hours	Task
4	Design New Controls
16	Implementation in Plot Dialog
4	Documentation
	
24	Subtotal




Save or Replace Single Plot in a Plot Page
Hours	Task
4	Modify PlotPageInfo class
6	Create Single Plot List Dialog
4	Modify Plot Dialog
4	Modify PlotPage Configuration Dialog
3	Update Documentation
	
21	Subtotal


Limit Curve Choices Based on Plot “Type”
Hours	Task
2	Modify PlotPageInfo class
5	Modify Plot Dialog
2	Modify SlotPlot Dialog
2	Modify PlotMembership Dialog
4	Modify PlotPage Configuration Dialog
3	Modify Output Manager Dialog
3	Update Documentation
	
21	Subtotal

Hours
196	GRAND TOTAL FOR ALL TASKS
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